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Using UBlearns Assessment Tools 
to Promote Student Learning 
Have you ever thought about whether your students think about your course 
outside of class time? Ever wondered if they have actually read the textbook 
prior to listening to your lecture on it? Do your students get together to study 
or discuss course content on their own time? All of these questions have 
crossed our minds and we have found that using some of the options in 
Blackboard on UBlearns can help guide students to achieve higher level 
learning objectives. At the very least, the functions in UBlearns can be used 
to ensure that your students will have read and thought about the assigned 
readings before coming to class. That alone can greatly improve their 
learning and your teaching effectiveness.

Although all teachers would like 
to have their students read the 
assigned materials before coming 
to class, we believe that this may 
be particularly important for teachers 
who want to achieve higher level 
learning objectives by using the 
assigned readings as a springboard 
for further discussion. Bloom’s 
Taxonomy defi nes six levels 
of cognitive learning objectives. 
The basic levels are knowledge 
and understanding. At these levels, 
students learn facts, defi nitions of 
concepts, and the like. These are 
building blocks for achieving the 
higher level objectives of application, 
analysis, synthesis and evaluation. 

We believe that most college students are capable of achieving knowledge 
and understanding through reading the text, but that they often have trouble 
achieving the higher level objectives without help from the instructor. To the 
extent that this is true, it suggests using classes to build on the knowledge 
and understanding that the student has acquired from reading the assigned 
material, not merely helping the student to organize and assimilate it. We 
both use such an approach, although we use it in somewhat different ways. 

In addition, we use different UBlearns features to foster higher level learning 
objectives, and to ensure that students come to class prepared. There are both 
quantitative and qualitative approaches available through features of UBlearns
that will ensure that the instructor will be able to build in class on student 
learning that has already taken place outside the classroom. 

Quantitative Methods to help students 
achieve knowledge and understanding

by Powhatan Wooldridge, Ph.D., School of Nursing

Perhaps the simplest way to ensure that students assimilate assigned readings 
at the knowledge and understanding levels is to use the Blackboard on UBlearns
Test Manager to give objective quizzes before class. Students are told that they 
must read the material assigned and take an “advance quiz” before they come 
to class. In my experience, this greatly increases the percentage of students 
who have read, and to some extent assimilated, the assigned text material 
before coming to class. 

Before I used advance quizzes, I found that only a small minority of students 
read the assigned readings before class. When I used advance quizzes, almost 
every student did the quiz before class. The Test Manager can be set to create 
separate tests for each student and attempt by drawing the questions for each 
test randomly from “pools” of questions from the assigned chapters. The 
purpose of the advance quizzes is primarily to foster learning (formatively), 
and only secondarily to assess the quality of the student’s performance 
(summatively). In order to follow a class discussion that focuses on the higher 
learning levels, students must fi rst read the material and assimilate it at the 
basic knowledge and understanding levels. Assigning quizzes to be taken 
before class solves this problem. While the quiz scores count towards the 
student’s fi nal mark, they are not weighted heavily in the student’s fi nal grade. 

As the spring semester begins to wind down, System and Application 
Administrators are planning summer updates. Our schedule is an ambitious 
one, including the installation of application updates, functionality enhance-
ments to the Blackboard Instructor Web Interface (BIWI) and a Course Removal 
process targeting courses older than, and including, the Fall ‘03 semester.

The UBlearns Support Team watches system resources, like disk space, to 
ensure that UBlearns remains stable while delivering current course content 
to faculty and students. Continued growth of UBlearns requires that we review learns requires that we review learns
the current policy of unrestricted retention of courses on the system. The most 
recent review has indicated that we have a “space crunch,” and therefore 
must limit the number of courses on the system and initiate a one-time 
selective Course Removal process.

Throughout the summer, individual course instructors affected by the Course 
Removal process will receive an email including a list of courses targeted for 
removal and a detailed description of the process. All affected courses removed
from the UBlearns system will be stored as zip fi les by the Application 
Administrator. Removed courses will be available for reinstallation for 
15 months. Instructors should contact ublearns@buffalo.edu for assistance.
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I allowed multiple attempts by the same student, with the score on each 
attempt replacing the previous score. If the student chose to redo the quiz, 
the student was not certain to do better on the retake, but repeated attempts 
did tend to improve the student’s score (as well as the student’s learning of the 
material). This made it relatively easy for students to score high on the quizzes. 
In effect, the quizzes had the status of required homework that was to be 
graded, but with a much lower time demand on student and instructor than 
the traditional qualitative approaches to homework would have required.

The advance quiz approach is most practical for courses that use a text for 
which objective questions have been provided by the publisher. If these are 
provided in electronic form, they can easily be uploaded directly into the 
Test Manager. They should be placed in separate question pools for each 
chapter. The exams can then be constructed quickly and graded automatically 
in UBlearns. The amount of student time required to take a short quiz should 
be about 10 to 15 minutes (exclusive of the time spent reading the required 
material). The amount of time required to set up each short quiz from the 
question pools should be less than 30 minutes, once the instructor has 
learned how to use the Test Manager. 

There is an interesting issue here for teachers who aspire to achieve high 
taxonomical learning levels in their students. Such teachers seldom rely on 
the kind of objective tests provided by publishers. Questions targeting learning 
at the higher taxonomical levels are likely to be in the minority. In addition, 
those questions that attempt to test learning at the higher taxonomical levels 
are often poorly written and/or ambiguous. As a result, most of us tend to rely 
instead on term papers, essay tests, or specially designed objective tests that 
we create ourselves. Ironically, this is actually an argument that favors the use 
of the test materials provided by publishers for the advance quiz approach. 
Since high learning level instructors are unlikely to want to use the publisher’s 
test materials for major exams, using them for advance quizzes has little 
or no down side. 

Using short answer essay quizzes to teach application & analysis
The short answer essay assessment feature of Blackboard on UBlearns is well 
suited for teaching application and analysis skills. In contrast to the advance 
quiz approach, these exams should be given after the techniques involved after the techniques involved after
in application and analysis have been demonstrated and discussed in class. 
They should still be thought of as primarily for formative purposes, rather 
than summative purposes, however. In my research methods class, I present 
a brief synopsis of a research study and its fi ndings, then asked short answer 
essay questions about such things as validity threats, interpretations, 
statistical issues, and practical application issues. 

When using such quizzes for formative purposes, it is important to keep 
in mind that their primary purpose is to foster learning, not to evaluate the 
student’s level of achievement. Still, it is important to provide constructive 
criticism, and also to provide model answers for the student to think about. 
Fortunately, UBlearns has the option to provide the student with model 
answers that can be seen only after the student submits their answers. 

Setting up a series of essay exams of this kind can be rather time consuming. 
I strongly suggest that the same essay exams be used every semester. I grade 
primarily on the amount of effort expended rather than the technical excellence 
of the answers. It is also important to provide the student with individualized
formative feedback, and once again, I suggest that these quizzes not 
be weighted heavily.

Summative testing, and testing for synthesis and evaluation
My preference is to use in-class exams for summative testing. For summative 
evaluations, it is important to be sure that the student is presenting his or her 
own work, and in-class exams are much better for that purpose. I do believe, 
however, in using previous exams for the formative essay exams discussed 

above. This lowers student anxiety and increases the perceived legitimacy 
of the in-class exam. As for evaluation and synthesis, I believe that the term 
paper is still the best place to require students to demonstrate those skills. 

Qualitative Methods Encourage Critical Thinking

by Christine Kroll, Ph.D, Graduate School of Education

UBlearns provides a number of tools to facilitate student learning and 
conversations between class sessions. In addition to posting scoring rubrics 
within the Course Documents section of UBlearns, I also begin the course with 
a diagnostic assessment of intelligences. The survey results are used to group 
my students. They remain within these groups for the entire semester. Each 
week a broad topic is introduced and each group is assigned a specifi c area 
within that topic to explore. They then develop presentations based on their 
facts and understanding of the material. Preparation for these in-class 
presentations occurs within the UBlearns Discussion Board. The following 
is a step-by-step account of the process:

Diagnostic Assessment
When using the UBlearns survey tool, I ask students to complete a 40 question
“Survey for Discovering your Strongest Intelligences” (Weber, 2004). This 
survey identifi es areas of student strengths. For example, results may reveal 
that a student’s learning style is visual-spatial, verbal-linguistic, or mathematical-
logical. I use the results to create small heterogeneous groups within the 
context of the larger class (50-70 students). When completing group work, 
students decide amongst themselves what portion of the project they would 
like to complete in the context of the overall assignment. Students who are 
strong in the “verbal-linguistic” area might choose to present the information 
gathered by the “mathematical-logical” learners. Although all students will 
be responsible for knowing all information, theoretically, the heterogeneous 
groups allow more students to complete course work using their strengths. 

Group Discussion Forums 
All students are expected to complete assigned readings before arriving to 
class. In response to the question/problem I have posted, stemming from the 
reading, they begin to research and formulate a response/solution which will 
be presented on campus to the entire class. 

I use the following grading scheme to encourage students to work together 
as a group. Each student receives two grades for their presentation: 

1. Many Grades to One Student: Online discussion boards and group meetings 
outside of class are peer reviewed by other group members using 
a six question reverse coded survey. 

2. One Grade to Many students: In-class group presentations are graded 
solely by the instructor. All group members receive the same grade, thereby 
creating a dependency upon the group to present a solid response to the 
assigned question/problem. 

Formative Assessment - Bringing students into the process
Students are asked to complete an online learning journal entry at regular 
intervals throughout the semester. They are asked to provide feedback on 
how the class is addressing their learning needs and offer suggestions for how 
things might be changed to clarify or improve their comprehension of material. 
Students have been surprisingly candid with their feedback and suggestions, 
which have become an integral part of the course. Student feedback helps 
me to identify potential problem areas before they become crisis areas. 

Objective Assessment—Time for a Test!  
At regular intervals, students complete tests in the course. The tests are 
currently taken in class; however, they could be delivered using the UBlearns
assessment system. Tests cover at least 3 learning units and are all multiple 
choice/multiple answer. Students are tested on all material presented in the 
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The Library Skills Workbook
via UBlearns: A Smoother 
Information Literacy Ride
A General Education information literacy requirement for UB undergraduates, 
the Library Skills Workbook has been around, in various incarnations, since Library Skills Workbook has been around, in various incarnations, since Library Skills Workbook
1980. In the olden days, before today’s hi-tech world, it was administered on 
paper and had to be completed in the library, where books and the card catalog 
reigned. Now, with the proliferation of electronic resources and a library that 
exists in a virtual space as well as a physical one, the Library Skills Workbook is Library Skills Workbook is Library Skills Workbook
available online. I have been involved with the Workbook’s online re-visioning Workbook’s online re-visioning Workbook’s
since 2000. The most recent development—administering the Workbook via Workbook via Workbook
UBlearns—is the most promising.learns—is the most promising.learns

The Workbook is a Web-based tutorial divided into fi ve sections: Using the Workbook is a Web-based tutorial divided into fi ve sections: Using the Workbook
Library, Doing Research, Finding Books, Finding Articles, and Using the Internet. 
Information-literate students who know how to do research using library and 
Internet sources are the ideal in an academic setting. But students are not fond of 
the Library Skills Workbook requirement, and librarians experience complications Library Skills Workbook requirement, and librarians experience complications Library Skills Workbook
with the process. Some students resist the Workbook and try to get exempt from Workbook and try to get exempt from Workbook
it. Many complete it at the end of their studies, when it is least useful to them. 
Many cheat because changing the answer key on a frequent basis is diffi cult due 
to technological limitations. The Workbook is labor intensive for the Libraries. Workbook is labor intensive for the Libraries. Workbook
When students complete it, their results are received via email and each test has 
to be graded manually. Students are emailed individually with their results. 

If they fail, they have to redo it, and these answers have to be graded and, once 
again, students have to be individually informed of their results. Once they pass, 
the Libraries manually update their DARS records. Sound tedious? It is.

This is where UBlearns comes in. Offering the learns comes in. Offering the learns Workbook on UBWorkbook on UBWorkbook learns has learns has learns
great advantages for both students and the Libraries. Instead of having one 
25-question document, the Workbook is divided into fi ve sections that can be Workbook is divided into fi ve sections that can be Workbook
completed independently of each other. If students fail a section, they redo 
the section they missed, not the entire test. They also get immediate feedback 
and they get their score for each section. The only time they need an individual 
email from the Libraries is when they need to redo a section, or when they need 
to have an Information Literacy Session (which is required if they fail twice). 
Cheating is also drastically cut, since each question a student gets is from a pool 
of randomly rotating questions. While the DARS records still have to be input 
manually (since UBlearns and DARS currently don’t communicate), the task of learns and DARS currently don’t communicate), the task of learns
processing the Workbook is signifi cantly diminished. It’s also easier for librarians Workbook is signifi cantly diminished. It’s also easier for librarians Workbook
to detect and fi x faulty questions because we can view the failed sections in the 
grade book. And for students who are familiar with UBlearns from other classes, learns from other classes, learns
it’s a much smoother ride. 

For the second semester in a row, in a pilot project coordinated by the Libraries 
with the assistance of Robin Sullivan in the Educational Technology Center, 
the Library Skills Workbook is being administered to a select group of students Library Skills Workbook is being administered to a select group of students Library Skills Workbook
via UBlearns. So far, students have given this version of the Workbook high Workbook high Workbook
ratings, and librarians are also pleased with the results. If all goes well, the 
online version currently available to most students will be a thing of the past, 
thanks to UBlearns. 
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book, online, in-class by the instructor and their peers. After each student 
presentation, students are allowed to hand in two or three questions they 
believe should be on the test. The instructor may or may not include these 
questions on the test. 

Summative Assessment - Reaching learning objectives & outcomes
The fi nal course project is a paper which will summarize the students’ under-
standing of course materials. It is a short paper (2-4 pages); however, it must 
be a refl ection of their own ideas and thoughts. The paper should also include 
citations to peer-reviewed literature supporting their viewpoints. Students are 
asked to submit their assignments via the UBlearns Digital Dropbox.

Additional Ideas for using UBlearns outside of class time: 
1. Debate —Post a controversial question within the UBlearns Group Discussion 

Boards. Next, divide the class (or group) into two teams, one called Team Pro, 
the other called Team Con. Give each team a defi nitive stance they must 
defend (regardless of their own opinions). 

2. Competition —Divide groups by gender, interests, vocation, etc. and provide 
guiding questions on the Group Discussion Board. Inform groups of extra 
credit points if they provide a more comprehensive answer to the question 
than their counterparts to spur competition, which often drives students 
to a higher level of achievement. 

3. Anti-“googling”—Post a general question and ask students to refrain from 
“googling” key words from the Internet. Once ideas have been generated, 
ask them to choose one or two. They should then spend time researching 
their idea(s). Move them beyond Google to the library by asking them to 
provide citations that support their statements. It opens up a whole new 
area of reading for them—peer-reviewed journals!

4. Students as Experts—Ask your students to become the expert for a given 
week and present in class using the UBlearns Discussion Board. Make one 

or two students the “expert” for a given week in your course. It is their task 
to read ahead and become well-versed on the subject matter. While you still 
create the discussion board question, it is the “moderator’s” responsibility 
to keep the conversation moving, check sources, and inspire their peers. 

5. What’s going on in other groups? Many of the ideas above require the 
UBlearns group function. To ensure students are seeing all sides of topics, 
create a “summarizer” assignment. This works very well with a moderator 
assignment. You ask the moderator from group 1 to summarize the group 
2 discussion board posts and vice versa. They will post the summaries within 
each group giving all students the opportunity to learn from the entire class. 
This exercise also allows the moderator to take full ownership of the unit 
they were assigned and empower them to continue research in that area.

UBlearns is an excellent tool to keep your students engaged outside of class 
time, supporting student-centered learning. Whether you decide to employ 
quantitative, qualitative, or a combination thereof, we hope these strategies 
will help you explore all that UBlearns has to offer. We believe using these 
strategies have improved our courses and set the stage for higher level 
thinking, transcending time and space, fostering critical thinking.

In addition to pushing students to higher level learning objectives, it allows 
and empowers students to take ownership of their own learning experience. 
As reviewed, students may reinforce or remediate concepts through objective 
testing and discussion board participation. UBlearns extends the physical learning learns extends the physical learning learns
community allowing students, who are often rushing from class to class, to get 
to know each other in an alternative setting. It provides an archive of student 
thoughts and ideas, to be revisited as often as necessary, in order for each 
student to gain knowledge and understanding and to further apply, analyze 
and work toward the higher learning objectives of synthesis and evaluation. 

Reference: Weber, Ellen. MI Strategies In The Classroom and Beyond 
Using Roundtable Learning. (Allyn and Bacon, 2004)

...end

by tatiana de la tierra, Information Literacy Librarian, Arts & Sciences Librariestatiana de la tierra, Information Literacy Librarian, Arts & Sciences Librariestatiana de la tierra
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UBlearns contacts: 
For software and technical support, contact Systems support: ublearns@buffalo.edu or 645-2803
For course development and instruction, contact Faculty support: etc@buffalo.edu or 645-7700

UBlearns Update is a newsletter for faculty and staff to share knowledge in the area of teaching and learning using UB’s centrally supported 
course management environment. UBlearns Update Newsletter is a joint publication of UBlearns Advisory Group, the UBlearns Support 
Team, the Educational Technology Center, and Instructional Technology Services. To submit articles for consideration, 
contact our editor Carole Ann Fabian, Director, Educational Technology Center at cafabian@buffalo.edu or 645-7700 x2.

Educational Technology Center
University Libraries
212 Capen Hall 
Buffalo, NY 14260-1680

Don Stein
User Services

Don Stein joined the Professional staff at User 
Services in 2002. Don provides in-class training for 
instructors on the use of UBlearns and is a liaison 
for UBlearns use in the Public Computing Sites.

Don is also a Student Access Manager for the 
Public Computing Sites. In this role, he supervises 
the operations of the Bell, Lockwood and ResHall 
computing sites. Don also teaches workshops 
on Microsoft Excel in the User Services 
workshop program.

Don is a native of Western New York and lives in Buffalo. In his free time 
Don likes to bike and travel.

M e e t  Y o u r  S u p p o r t  S t a f f

The UBlearns Support Team looks forward to the summer as a time to consider learns Support Team looks forward to the summer as a time to consider learns
improvements to UBlearns service, support and functionality. Support Team learns service, support and functionality. Support Team learns
members will be attending the annual Blackboard Users Conference to learn 
what’s new, to interact with colleagues from other Blackboard subscribing 
institutions, to learn how faculty are using UBlearns to enhance instruction, learns to enhance instruction, learns
and to give feedback to Blackboard developers on needed improvements 
to the software.

Summer is a great time for UB instructors to build course content for fall 
courses. The Support Team is available to assist instructors in preparing 
course documents and in customizing their UBlearns course site. Contact learns course site. Contact learns
etc@buffalo.edu for individualized assistance. We are continually adding 
new “tips and techniques” to the UBlearns site in the form of best practice learns site in the form of best practice learns
documents. To view all our user support documentation, go to 
ublearns.buffalo.edu > select the Faculty tab > Best Practices. 
Currently available:

• Best Practices for PowerPoint
• Best Practices for Streaming Video
• Best Practices for End of Semester Procedures

During the summer months, the ETC continues to offer group and 
individualized training and course development to all UB faculty and staff. 
Contact us at etc@buffalo.edu to schedule a consultation on your instructional 
support needs.

   — Carole Ann Fabian

From the Editor

To view schedule and register for upcoming UBlearns 
workshops,

GO TO > etc.buffalo.edu > Instruction > Workshops

W o r k s h o p s



End of Semester 
Procedures
This document outlines how student 
enrollments in UBlearns are handled at learns are handled at learns
the end of the semester, how to deal with 
student incompletes, and how to save 
grades and user submissions (discussion 
board postings, chat archives, assignments, 
papers submitted through the Digital 
Dropbox, etc.).

Basic Recommendation
Instructors are responsible for providing 
access to UBlearns for students with 
incompletes. Instructors should make 
copies of grades and user submissions 
for their records. 

Discussion:
Student enrollments
Approximately three weeks after the last day of classes, enrollments 
in all UBlearns course sites are disabled. This makes the course 
unavailable to students, TAs, Course Builders and Graders.

• Disabled users no longer have access to the course site.
• Disabled users no longer receive course communications

(email, announcements, grades, tasks and calendar dates). 
• Disabled-user data remain linked to the user record 

but are hidden.
• Disabled users cannot be re-enabled via the control panel. 

See Incomplete Report Form to have a student re-enabled: 
ublearns.buffalo.edu/bin/incomplete.pl

Instructors will continue to have access to course content only, 
not to student submissions or grades. This applies only to courses 
enabled on UBlearns using the BIWI (Blackboard Instructor Web 
Interface). Courses enabled using the BIWI have course IDs 
formatted like 200406_123456 (representing the year, 
month and registration number).

Students with an incomplete 
If you have students with an incomplete (fi nal grade) and would 
like them to continue to access the course, please see the
Incomplete Report Form: ublearns.buffalo.edu/bin/incomplete.pl

• What courses are affected? 
– Offi cial credit-bearing courses which have been enabled 

  for UBlearns by the BIWI. 
– Courses for the current semester after the last day of classes. 
– Courses for previous semesters starting with Fall 2003. 

• What students are affected? 
– Students offi cially registered for the course. 
– Students enrolled in courses for previous semesters starting 

  with Fall 2003. 

• When would you use this form?
– To give a student access to a course site after the end 

  of a semester. 
– To extend student access to courses that use the same course 

  site for more than one semester. 
Students manually added to a UBlearns course by the faculty 
(or administrators) are not visible on this form.

Retaining copies of grades and user submissions
If you wish to keep copies of user submissions from your UBlearns
course, you need to follow these instructions. 

Save gradebooks
• Select “Gradebook” from the course control panel.
• Select the “Download Grades” button. 
• The page will refresh. Read the instructions and select the 

“Download” button. 
• Once downloaded, the fi le can be viewed in a database 

or spreadsheet program, such as Excel or Access. 

Note: Browsers other than Internet Explorer for PC will display the gradebook 
data in the browser. Copy the information and paste into a word processing 
program. Save the fi le in plain text format and use the .csv extension.

Save discussion board postings and chat archives
Since UBlearns uses frames, you must fi rst open the discussion 
board text or chat archive in a new window. Do this by right 
clicking on the link to the discussion board or chat archive 
and select “Open in new window.” 

To view all messages of a discussion board forum on a single 
screen, click the “show options” tab, then click “select all,” and 
“collect.” Messages will display in the order they were posted. 
A drawback to this is that you loose the threaded nature 
of the messages.

Then choose one of the following options:

• Save as text:
Highlight the text to save. Select Edit > Copy. Open a word 
processor and paste the text you copied. Save the fi le.

• Save as a Web document using Internet Explorer:
Select File > Save As. Change the Save as Type menu to 
Web Page (HTML). Name the fi le and save. You will be 
able to open the fi le in a word processing software.

• Print document:
Open the view you would like to print. Select File > Print.

Save Assignments submitted using the Assignment function 
To save fi les submitted using the Assignment function, go to 
Control Panel > Gradebook. Select the title of the gradebook 
item for the assignment you wish to download. Follow 
onscreen instructions.

Save papers submitted to the Digital Dropbox
To save fi les submitted through the Digital Dropbox, go to 
Control Panel > Digital Dropbox. Select the documents you 
wish to download, and follow onscreen instructions.

Questions or Comments
If you have any questions or would like to report additional 
information about this issue please send an email to 
UBlearns@buffalo.edu. Thank you.

Updated March 22, 2005 
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Sample multiple choice question created in MS Excel.  
(MC indicates multiple choice)

 MC The roses are __. red correct blue incorrect orange incorrect

Sample multiple choice question created in NotePad.  
Note: When using any text editor, be sure to turn the word 
wrapping format option off. 

 MC The roses are __. red correct blue incorrect  orange incorrect

Sample Multiple Choice Question

Preparing Tests for 
Delivery via UBlearns
While UBlearns offers a complete assessment area for creation 
and delivery of tests, there are alternative test-creation methods 
worth exploring for those who fi nd UBlearns assessment area too 
time-consuming or restrictive for their needs. This article presents 
a summary of current test-creation options.

Respondus
The University has acquired a license for a powerful test creation 
and management software, Respondus 2.0. Respondus is an easy 
to learn graphical software application that can help you build tests 
and surveys offl ine and then upload them to UBlearns later. With 
Respondus, you can create, manage and store tests, surveys and 
question sets (a.k.a. “pools”) for all of your courses on your own 
computer. Connect to UBlearns when you are ready to import 
and release the tests to your students. Respondus is a Windows 
application, but can work from the MAC OS using emulation 
software, such as Virtual PC. 

Instructions and download of Respondus are available on the 
UBlearns Welcome page in the Faculty Updates area, or by going 
directly to: ublearns.buffalo.edu/ublearns/0Respondus.html

Importing Questions into UBlearns
UBlearns accepts externally created question fi les that conform 
to a specifi c fi le structure which follows certain rules for each 
question format. Questions and answers are often separated 
by the use of the TAB key. Acceptable question formats include 
any combination of essay, ordering, matching, fi ll in the blank, 
multiple choice, multiple answer, or true/false. Text editors such 
as WordPad, Notepad, TextEdit or even MS Excel can be used 
to create a question fi le. Each question type has its own simple 
formatting rules. Generally, each question begins with the 
question type and all the Blackboard question types are supported. 

When constructing question fi les, organizing questions by level of 
diffi culty, point value, and question type provide the most effi cient 
use of this method. Presently, the inclusion of correct/incorrect 
feedback directly into the question fi le is not a feature of this 
process. To add feedback to uploaded questions you need to use 
the edit test canvas and add the feedback question by question.

To import questions you fi rst open the Pool or Test Manager from 
the course “Control Panel” and build a new pool or test. Once the 
pool or test is created “modify” the test. In the “Add” tool bar 
use the pull down menu to select the “Upload Questions” option 
and select “GO”. You will be asked to browse your computer for a 
questions fi le to import. You will also be asked to assign a “Points 
per question” value. After the import is complete you will be 
returned to the “modify” test canvas and the questions imported 
will be shown after the last question in the test.

Import a pool into Blackboard
Blackboard has specifi ed a format for the import and export of test 
pools. Many publishers offer tests formatted for Blackboard. It is 
a good practice to build pools fi rst and then create tests from the 
pools. To import a pool select the “Pool Manager” from the course 
“Control Panel” and choose the “upload pool” option from the 
“Add” tool bar. 

Quiz Generation Tools
In researching this article, we found an automated quiz 
generation tool on the Web created and supported by staff 
at Wytheville Community College. The site provides step-by-step 
instructions and allows you to create a test on the fl y, then exports 
your question fi le in a packaged fi le (.zip). This fi le can then be 
imported into UBlearns following the “importing question” steps 
outlined above. 
www.wcc.vccs.edu/services/blackboard/

SCORM
The Sharable Content Object Reference Model (SCORM) is 
supported by Blackboard and is accessed through the document 
creation canvas in any document area of your course. Once in 
the document creation canvas you can choose “SCORM Content” 
from the “select” menu at the right of the “Add” tool bar. You 
will be asked to browse your computer for a SCORM package 
and upload it. You can choose options for the package: the 
method of presentation, whether to track use of the package, 
whether to include the package in the Gradebook, and whether 
to force completion of content. 

To create a Sharable Content Object (SCO) you will need to use 
a development tool of some kind. Among the more popular tools 
today are Captivate and Authorware, software available from 
Macromedia, who also has SCORM-exporting tools or methods 
for many of its other products. You can also fi nd many SCOs 
that have already been created for a variety of topics by 
searching the Internet. Many publishers are starting to produce 
SCORM compliant content with their textbooks as well. 

The Advanced Distributed Learning Web site has a complete history 
of SCORM and many helpful links and resources including a tool 
for locating certifi ed products and third party development tools.
adlnet.org/index.cfm?fuseaction=scormabt

Questions or Comments
For instructional support in building tests contact: etc@buffalo.edu.
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